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Safety first
Your new phone is a convenient and effective communications tool, but it can be 
hazardous when used improperly. To avoid harming yourself or anyone else, please 
review the following information before using your phone.

Batteries
Batteries can cause property damage, injury, or burns if the terminals are touched with a 
conductive material (for example, metal jewellery, keys, and so on). Therefore, use 
caution when handling a charged battery. Additional precautions and notes are listed 
below:
• Never throw a battery into a fire; it may explode.
• Fully recharge the battery if the battery is low or as soon as the low-battery alert beeps.
• Do not drop the battery.
• Do not allow bridging of battery contacts with metallic objects.
• Do not remove the battery from the phone while the phone is powered on. Settings you 

have changed may revert to their previous settings.
A recyclable lithium ion/polymer battery powers your phone. Please call
1-800-8-BATTERY for information on how to recycle the battery.

Charging devices
Use only Genuine Panasonic charging accessories. Use of attachments not recommended 
by Panasonic or your Service Provider may result in fire, electrical shock, or injury.
Panasonic is not responsible for damage caused by using non-Panasonic accessories.
• Do not expose charging adapters to moisture, water, or the weather.
• Do not use an adapter with a damaged cord.
• When using a DC adapter in an automobile, a small amount of electricity flows 

through the adapter, even if the phone is turned off. Remove the plug from the 
cigarette lighter whenever the phone will be left in the vehicle for long periods of time.

• Always charge the battery in a well ventilated area, not in direct sunlight, between 
41°F (5°C) and 95°F (35°C). It is not possible to recharge the battery if it is outside 
this temperature range.

• Do not incinerate or dispose of the battery as ordinary trash. The battery must be 
disposed of in accordance with local legislation and may be recycled.

Caution: The cigarette lighter must have a 12V negative ground socket. Do not use the 
adapter in a vehicle that has a positive ground system.

General
• Do not use the phone in extreme temperature or humidity. The specified operating 

temperature range is -22°F to +140°F (-30°C to +60°C).
• Extreme temperatures may have a temporary effect on the operation of your phone. 

This is normal and does not indicate a fault.
• Do not expose the phone (particularly the display) to direct sunlight for extended 

periods of time or to a humid, dusty or hot area.
• Do not attempt to disassemble the phone. There are no user-serviceable parts inside.
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• Do not subject the equipment to excessive vibration or shock.
• Do not expose the phone to rain or spill liquids on it. If the equipment becomes wet 

immediately remove the battery and charging device and contact your dealer.
• Do not use any accessories other than those designed for use with your phone.
• Use of attachments not recommended or sold by Panasonic or your Service Provider 

may result in fire, electrical shock, or injury.
• Panasonic is not responsible for damages caused by using non-Panasonic accessories.
• Pressing any of the keys may produce a loud tone. Avoid holding the phone close to 

the ear while pressing the keys.
• Keep metallic items that may accidentally touch the battery terminals away from the 

equipment. Battery damage may occur.
• When disposing of any packing materials or old equipment check with your local 

authorities for information on recycling.
• If connecting the phone to an external source, read the operating instructions of the 

equipment for the correct connection and safety precautions.
• If connecting the phone to an external source, verify that the phone is compatible with 

the product to which you are connecting it.

Availability of service
This phone, like any wireless phone, operates using radio signals, wireless and landline 
networks, and user-programmed functions. Because of this, connection in all conditions 
cannot be guaranteed. Therefore, you should never rely solely on any wireless phone for 
essential communications (for example, medical emergencies).

Emergency (911) service
If you need to make an emergency (911) call, power the phone on, dial 911, and press D.
Emergency calls can be made regardless of lock setting and with or without a SIM card.
Remember, to make or receive any call, the phone must be switched on and in a service 
area that has adequate signal strength. Even if you are within the coverage area of your 
Service Provider, you may be in an area with insufficient signal strength to place a 911 
call. Emergency calls might not be possible on all wireless phone networks or when 
certain network service and/or phone features are in use.
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Safety tips
Following the suggestions in this section will help ensure safe and efficient operation of 
your Panasonic phone.
This Model Phone Meets The Government’s Requirements For Exposure To Radio 
Waves.
Your wireless phone is a radio transmitter and receiver. It is designed and manufactured 
not to exceed the emission limits for exposure to radiofrequency (RF) energy set by the 
Federal Communications Commission of the U.S. Government. These limits are part of 
comprehensive guidelines and establish permitted levels of RF energy for the general 
population. The guidelines are based on standards that were developed by independent 
scientific organizations through periodic and thorough evaluation of scientific studies. 
The standards include a substantial safety margin designed to assure the safety of all 
persons, regardless of age and health.
The exposure standard for wireless mobile phones employs a unit of measurement known 
as the Specific Absorption Rate, or SAR. The SAR limit set by the FCC is 1.6W/kg. Tests 
for SAR are conducted using standard operating positions specified by the FCC with the 
phone transmitting at its highest certified power level in all tested frequency bands. 
Although the SAR is determined at the highest certified power level, the actual SAR level 
of the phone while operating can be well below the maximum value. This is because the 
phone is designed to operate at multiple power levels so as to use only the power required 
to reach the network. In general, the closer you are to a wireless base station antenna, the 
lower the power output.
Before a phone model is available for sale to the public, it must be tested and certified to 
the FCC that it does not exceed the limit established by the government-adopted 
requirement for safe exposure. The tests are performed in positions and locations (e.g., at 
the ear and worn on the body) as required by the FCC for each model. The highest SAR 
value for this model phone when tested for use at the ear is 0.825 W/kg and when worn 
on the body, as described in this user guide, is 0.687 W/kg. (Body-worn measurements 
differ among phone models, depending upon available accessories and FCC 
requirements). While there may be differences between the SAR levels of various phones 
and at various positions, they all meet the government requirement for safe exposure.
The FCC has granted an Equipment Authorization for this model phone with all reported 
SAR levels evaluated as in compliance with the FCC RF emission guidelines. SAR 
information on this model phone is on file with the FCC and can be found under the 
Display Grant section of http://www.fcc.gov/oet/fccid after searching on FCC ID 
NWJ21C001A.
Additional information on Specific Absorption Rates (SAR) can be found on the Cellular 
Telecommunications Industry Association (CTIA) web-site at 
http://www.wow-com.com.
Caution:  All Panasonic branded accessories are tested and comply with FCC RF 
exposure requirements. Non-Panasonic accessories may not comply.
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Body-worn operation
This device was tested for body-worn operations with the back of the phone kept 1.5 cm. 
from the body. To maintain compliance with FCC RF exposure requirements, use only 
belt-clips, holsters or similar accessories that maintain a 1.5 cm. separation distance 
between the user’s body and the back of the phone. The use of belt-clips, holsters and 
similar accessories should not contain metallic components in its assembly. The use of 
accessories that do not satisfy these requirements may not comply with FCC RF exposure 
requirements, and should be avoided.

Antenna care
This mobile phone incorporates an internal antenna for radio communisation. Do not use 
the phone if it is damaged. Unauthorized antennas, modifications, or attachments could 
damage the phone and may violate FCC regulations.

Driving
Important: Check the laws and regulations on the use of wireless telephones in the areas 
where you drive. Always obey them. Also, if using your phone while driving:
• Give full attention to driving - driving safely is your first responsibility;
• Use handsfree operation, if available;
• Pull off the road and park before making or answering a call if driving conditions so 

require.

Electronic devices
Most modern electronic equipment is shielded from RF signals. However, certain 
electronic equipment may not be shielded against the RF signals from your wireless 
phone.
Pacemakers: The Health Industry Manufacturers Association recommends that a 
minimum separation of 6 inches (6”) or 15 centimeters (15 cm) be maintained between a 
handheld wireless phone and a pacemaker to avoid potential interference with the 
pacemaker. These recommendations are consistent with independent research and 
recommendations of Wireless Technology Research.
Persons with pacemakers:
• Should ALWAYS keep the phone more than six inches from their pacemaker when 

the phone is turned ON;
• Should not carry the phone in a breast pocket;
• Should use the ear opposite the pacemaker to minimize the potential for interference;
• If you have any reason to suspect that interference is taking place, turn your phone 

OFF immediately.
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Hearing Aids: Some digital wireless phones may interfere with some hearing aids. In the 
event of such interference, consult your Service Provider and hearing aid manufacturer.
Other Medical Devices: If you use any other personal medical device, consult the 
manufacturer of your device to determine if it is adequately shielded from external RF 
energy. Your physician may be able to assist you in obtaining this information.
Turn your phone OFF in health care facilities when any regulations posted in these areas 
instruct you to do so. Hospitals or health care facilities may be using equipment that could 
be sensitive to external RF energy.
Vehicles: RF signals may affect improperly installed or inadequately shielded electronic 
systems in motor vehicles. Check with the manufacturer or its representative regarding 
your vehicle. You should also consult the manufacturer of any equipment that has been 
added to your vehicle.
Posted Facilities: Turn your phone OFF in any facility where posted notices so require.

Aircraft
FCC regulations prohibit using your phone while in the air; switch off your phone before 
boarding an aircraft unless otherwise advised by airline personnel.

Blasting areas
To avoid interfering with blasting operations, turn your phone OFF when in a “blasting 
area” or in other areas posted:  “Turn off two-way radio.” Obey all signs and instructions.

Potentially explosive atmospheres
Turn your phone OFF when in any area with a potentially explosive atmosphere and obey 
all signs and instructions. Sparks in such areas could cause an explosion or fire resulting 
in bodily injury or even death.
Areas with a potentially explosive atmosphere are often, but not always, clearly marked. 
They include fueling areas such as gas stations; below deck on boats; fuel or chemical 
transfer or storage facilities; vehicles using liquefied petroleum gas (such as propane or 
butane); areas where the air contains chemicals or particles, such as grain, dust or metal 
powders; and any other area where you would normally be advised to turn off your 
vehicle engine.

For vehicles equipped with an air bag
An air bag inflates with great force. DO NOT place objects, including both installed or 
portable wireless equipment, in the area over the air bag or in the air bag deployment area. 
If in-vehicle wireless equipment is improperly installed and the air bag inflates, serious 
injury could result.
For U.S. Customers: Vehicles using liquefied petroleum gas (such as propane or butane) 
must comply with the National Fire Protection Standard (NFPA-58).
For a copy of this standard, contact:
National Fire Protection Association
One Batterymarch Park
PO Box 9101
Quincy, MA 02269
Phone: 1-800-344-3555
Web site: www.nfpa.org   E-mail address: Custserv@NFPA.org
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F C C / C E / I C S T A T E M E N T S

DECLARATION OF CONFORMITY WITH FCC RULES FOR 
ELECTROMAGNETIC COMPATIBILITY

We, Panasonic Mobile Communications Co., Ltd., declare under our sole
responsibility that the product,

X800
to which this declaration relates, this device complies with Part 15 of the FCCRules. Operation is subject to the
to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation.

Caution: Exposure to Radio Frequency Radiation.
This device and its antenna must not be co-located or operating in conjunction with any other antenna or  
transmitter.

Federal Communications Commission Notice
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection. This equipment generates, uses
and can radiated radio frequency energy and, If not installed and used in accordance with the instructions, may cause
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F C C / C E / I C S T A T E M E N T S

harmful interference to radio communications. However, there is no guarantee that interference will not occur in a
particular installation If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Modifications
The FCC requires the user to be notified that any changes or modifications to this device that are not expressly
approved by Panasonic may void the users authority to operate the equipment.

Canada-Industry Canada (IC)
The wireless radio of this device complies with RSS 139 & RSS 210 Industry Canada.  This Class B digital complies with
Canadian ICES-003.
Cet appareil numérique de la classe B conforme á la norme NMB-003 du Canada.

Europe-European Union Notice
Radio products with the CE 0560 or CE alert marking comply 
with the R&TTE Directive (1995/5/EC) issued by the Commission 
of the European Community.         
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TEN (10) DRIVER SAFETY TIPS
Your wireless telephone gives you the powerful ability to communicate by voice-almost anywhere, 
anytime. But an important responsibility accompanies the benefits of wireless phones, one that 
every user must uphold.
When driving a car, driving is your first responsibility. When using your wireless phone behind the 
wheel of a car, practice good common sense and remember the following tips:
1. Get to know your wireless phone and its features such as speed dial and redial. If 

available, these features help you to place your call without taking your attention off the 
road.

2. When available, use a hands free device. If possible, add an additional layer of 
convenience and safety to your wireless phone with one of the many hands free 
accessories available today.

3. Position your wireless phone within easy reach. Be able to access your wireless 
phone without removing your eyes from the road. If you get an incoming call at an 
inconvenient time, if possible, let your voice mail answer it for you.

4. Let the person you are speaking with know you are driving; if necessary, 
suspend the call in heavy traffic or hazardous weather conditions. Rain, sleet, 
snow, ice, and even heavy traffic can be hazardous.

5. Do not take notes or look up phone numbers while driving. Jotting down a "to do" 
list or flipping through your address book takes attention away from your primary 
responsibility, driving safely.

6. Dial sensibly and assess the traffic; if possible, place calls when you are not 
moving or before pulling into traffic. Try to plan calls when your car will be 
stationary. If you need to make a call while moving, dial only a few numbers, check the 
road and your mirrors, then continue.

7. Do not engage in stressful or emotional conversations that may be distracting. 
Make people you are talking with aware you are driving and suspend conversations 
that have the potential to divert your attention from the road.

8. Use your wireless phone to call for help. Dial 9-1-1 or other local emergency number 
in the case of fire, traffic accident or medical emergencies. Remember, it is a free call 
on your wireless phone!

9. Use your wireless phone to help others in emergencies. If you see an auto 
accident, crime in progress or other serious emergency where lives are in danger, call 
9-1-1 or other local emergency number, as you would want others to do for you.

10. Call roadside assistance or a special non-emergency wireless assistance 
number when necessary. If you see a broken-down vehicle posing no serious hazard, 
a broken traffic signal, a minor traffic accident where no one appears injured, or a 
vehicle you know to be stolen, call roadside assistance or other special non-emergency 
wireless number.

"The wireless industry reminds you to use your phone safely when driving."
For more information, please call 1-888-901-SAFE or 
visit www.wow-com.com
Information on this page provided by the Cellular Telecommunications Industry 
Association.
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HIGHLIGHTS
Here are just some of the things you can do with the X800 mobile phone.

• Send colour pictures and video clips 
to friends and family via Multimedia 
messaging and e-mail messaging.

• Send pictures, video, electronic 
business cards, and more using 
Bluetooth®, Infrared, or USB 
connections to other phones or devices.

• Swap content between appropriate 
devices with the included miniSD Card 
and adapter.

• Surf the Internet using your XHTML 
configured wireless Internet browser.

• Add frames, text, and pop art to VGA 
size images.

• Capture video clips.

• Play 40 tone polyphonic ringtones.

• No more wired headset! Use a 
Bluetooth® wireless headset.

• Synchronise your Contacts and 
Calendar with your other networked 
devices.

• See who is calling with picture Caller 
Line ID on the X800 external display.

• Download games, images, themes, 
sounds, videos, and Java™ and Series 
60 applications. 

• View all your media files in one place, 
the Media Gallery.

• Search for your files; including games, 
images, install packages, and video and 
sound clips.

• Receive, edit, and view Microsoft® 
Word, Excel, and PowerPoint® files. 
Beam documents to printers and 
projectors (with appropriate accessory).

• Speak a name or number to dial the 
number using Voice Commands.

• Say “open Messages” or “open 
Camera” and your phone will go directly 
to the application using Voice 
Commands.
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IMPORTANT INFORMATION
Thank you for purchasing this Panasonic digital cellular phone. This phone is designed 
to operate on GSM networks - GSM900, GSM1800 and GSM1900. It also supports 
GPRS for packet data connections. Please ensure the battery is fully charged before 
use.

Safety Considerations
Please read and understand the following information as it provides details for operating 
your phone in a manner which is both safe to you and your environment, and conforms 
to any legal requirements regarding the use of cellular phones.

This equipment should only be charged with approved charging equipment to ensure
optimum performance and avoid damage to your phone. Other usage will invalidate any
approval given to this equipment and may be dangerous. Ensure the voltage rating of the
Travel Charger is compatible with the area of use when travelling abroad. A Travel Charger
(EB-CAX70xx)* is supplied with the main kit. Car Charger (EB-CDX70) is also
recommended for charging. *Note: xx identifies the charger region, e.g. AU, CN, EU, UK,
US.

Use of a battery pack other than that recommended by the manufacturer may result in a
safety hazard. Never expose the battery to extreme temperatures (over 60º C or 140º F). It
is normal for your battery to become warm to the touch when charging. Camera use,
keeping Bluetooth switched on, Internet browsing, extended gaming, and downloading data
reduces battery life.

Cellular phones can cause interference in an aircraft. Switch off your cellular phone when in
an aircraft. The use of cellular phones in an aircraft may be dangerous to the operation of
the aircraft, disrupt the cellular network and may be illegal. Failure to observe this instruction
may lead to the suspension or denial of cellular phone services to the offender, or legal
action or both.

Alarms should not be set to switch on the phone when you are in an aircraft, near sensitive
medical equipment, at a refuelling point or when it may cause interference or danger.

Do not incinerate or dispose of the battery as ordinary rubbish. The battery must be
disposed of in accordance with local legislation and may be recycled. 

It is advised not to use the equipment at a refuelling point. You are reminded to observe
restrictions on the use of radio equipment in fuel depots, chemical plants or where blasting
operations are in progress. 

Never expose the battery to extreme temperatures (over 60º C or 140º F).

Power

Battery

Aircraft

Alarm

the Battery
Disposing of

Do not use
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It is imperative that the driver exercises proper control of the vehicle at all times. Do not hold
a phone while you are driving; find a safe place to stop first. Do not speak into a handsfree
microphone if it will take your mind off the road. Always acquaint yourself thoroughly with
restrictions concerning the use of cellular phones within the area your are driving and
observe them at all times.

Care must be taken when using the phone in close proximity to personal medical devices,
such as pacemakers and hearing aids.

For most efficient use hold the phone as you would any normal phone. To avoid
deterioration of signal quality or antenna performance, do not touch or cup the antenna area
while the phone is switched on. Unauthorised modifications or attachments may damage the
phone and violate applicable regulations. The use of an unapproved modification or
attachment may result in the invalidation of your guarantee – this does not affect your
statutory rights.

When your handset, the accompanying battery, or charging accessories are wet, do not put
those in any type of heating equipment, such as a microwave oven, a high pressure
container, or a drier or similar. It may cause the battery, handset and/or charging equipment
to leak, heat up, expand, explode and/or catch fire. Moreover, the product or accessories
may emit smoke and their electrical circuits may become damaged and cause the products
to malfunction. Panasonic is not responsible for any and all damages, whether direct or
indirect, howsoever caused by any misuse. 

It is recommended that you create a copy or backup, as appropriate, of any important
information and data which you store in your phone’s memory. In order to avoid accidental
loss of data, please follow all instructions relating to the care and maintenance of your
phone and its battery. Panasonic accepts no liability for any and all losses howsoever arising
from any loss of data, including but not limited to direct and indirect losses (to include, but
not limited to consequential loss, anticipated savings, loss of revenue).

Your phone has the capability of storing and communicating personal information. It is
recommended that you take care to ensure that any personal or financial information is
stored separately from your phone. You should use security features, such as the SIM lock
to protect information held in your phone. Panasonic accepts no liability for any and all
losses howsoever arising from any loss of data, including but not limited to direct and
indirect losses (to include, but not limited to consequential loss, anticipated savings, loss of
revenue).

Your phone has the capability of downloading and storing information and data from external
sources. It is your responsibility to ensure that in doing this you are not infringing any
copyright laws or other applicable legislation. Panasonic accepts no liability for any and all
losses howsoever arising from any loss of data or any such infringement of copyright or
intellectual property rights, including but not limited to direct and indirect losses (to include,
but not limited to consequential loss, anticipated savings, loss or revenues). 

Driving

Electronic
Devices

Efficient
Use

Heating
Equipment

and Security

Backup
Copies

Downloading
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You are advised to take appropriate care over the use of the internal camera. It is your
responsibility to ensure that you have permission to take photographs of people and objects
and that you do not infringe any personal or third party rights when using the camera. You
must comply with any applicable international or national law or other special restrictions
governing camera use in specific applications and environments. This includes not using the
camera in places where the use of photographic and video equipment may be prohibited.
Panasonic accepts no liability for any and all losses howsoever arising from any
infringement of copyright or intellectual property rights, including but not limited to direct and
indirect losses. 

Do not leave the camera facing direct sunlight, as this may impair its performance.

The colour liquid crystal display (LCD) uses high-precision production technology, and in certain
circumstances pixels may appear brighter or darker. This is due to characteristics of the LCD and is not a
manufacturing defect. 

The display layouts and screenshots within this document are for illustrative purposes and may differ from
the actual displays on your phone. Panasonic reserves the right to change the information in this document
without prior notice.

This equipment should only be used with Panasonic approved accessories to ensure optimum
performance and avoid damage to your phone. Panasonic is not responsible for damages caused by using
non-Panasonic approved accessories.

This Panasonic mobile phone is designed, manufactured and tested to ensure that it complies with the
specifications covering RF exposure guidelines applicable at the time of manufacture, in accordance with
EU, USA FCC, and Australian ACA regulations.

Please refer to our website for latest information/standards and compliance in your country/region of use.
http://www.panasonicmobile.com

CARE AND MAINTENANCE
Pressing any of the keys may produce a loud tone. Avoid holding the phone close to your ear
while pressing the keys.

Extreme temperatures may have a temporary effect on the operation of your phone. This is
normal and does not indicate a fault.

If you use your phone in a temperature over 40°C for a long time, the display quality may
deteriorate.

Do not modify or disassemble the equipment. There are no user serviceable parts.

Do not subject the equipment to excessive vibration or shock.

Do not drop the battery.

Camera
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Avoid contact with liquids. If the equipment becomes wet immediately remove the battery and
contact your dealer.

Do not leave the equipment in direct sunlight or a humid, dusty, or hot area.

Never throw a battery into a fire. It may explode.

Keep metallic items that may accidentally touch the terminals away from the equipment/battery.

Batteries can cause property damage, injury, or burns if terminals are touched with a conductive
material (i.e. metal jewellery, keys, etc.).

Always charge the battery in a well ventilated area, not in direct sunlight, between +5°C and
+35°C. It is not possible to recharge the battery if it is outside this temperature range.

When connecting the phone to an external source, read the operating instructions of the
equipment for the correct connection and safety precautions. Ensure the phone is compatible with
the product it is being connected to.

When disposing of any packing materials or old equipment check with your local authorities for
information on recycling.
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END-USER SOFTWARE LICENSE AGREEMENT
By use of this Panasonic cellular phone, including any embedded software features or programs
("Embedded Software"), you agree to the terms and conditions of this End-User Software License
Agreement ("EULA").

1. END-USER RIGHTS:  You are granted a limited end-user right to use the Embedded Software only as
part of and together with this Panasonic cellular phone. You agree to use the Embedded Software in a
manner that complies with all applicable laws, including laws related to copyright and other intellectual
property rights. All other uses are prohibited.

2. LIMITATIONS ON END-USER RIGHTS:
(a) You may not reproduce, copy, or transfer the Embedded Software to any other device;
(b) You may not create derivative works of any type based on the Embedded Software (unless and except

as expressly permitted as part of a feature application);
(c) You may not reverse engineer, reverse compile, disassemble, or otherwise attempt to discover the

source code of the Embedded Software;
(d) You may not transfer this Panasonic cellular phone other than to a transferee end-user who undertakes

to observe the same obligations as those set out in this EULA;
(e) You may not remove any proprietary notices, such as copyright, trademark, or otherwise, from the

Embedded Software.

3. INTELLECTUAL PROPERTY RIGHTS:  The Embedded Software is protected by copyright, trademark,
patent and/or other intellectual property rights and is owned by Panasonic Mobile Communications Co.,
Ltd. ("PMC") and/or is under license from PMC's licensors.

4. TERMINATION:  Your right to use the Embedded Software may be terminated for failure to comply with
any of the terms of this EULA.

5. LIMITATION OF LIABILITY/DISCLAIMER OF WARRANTIES:  TO THE MAXIUM EXTENT PERMITTED
BY APPLICABLE LAW, IN NO EVENT SHALL PMC, ITS AFFILIATES, AND THEIR LICENSORS BE
LIABLE FOR INCIDENTAL, INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THE EMBEDDED SOFTWARE. EXCEPT AS
EXPRESSLY STATED IN THE RELEVANT WARRANTY CARD, PMC, ITS AFFILIATES, AND THEIR
LICENSORS DISCLAIM ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING, WITHOUT
LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE REMEDIES PROVIDED TO THE END-USER IN THE RELEVANT WARRANTY CARD
ARE EXCLUSIVE.

6. ADDITIONAL THIRD PARTY TERMS:  The Embedded Software may contain third party software
subject to separate third party license terms and conditions set forth in the user manual or associated
product documentation and/or displayed on the LCD of this Panasonic cellular phone. You acknowledge
and agree that such third party software is governed by the third party license terms, as applicable, and that
such terms are solely between you and the applicable licensor.

7. EXPORT REGULATIONS/RESTRICTED RIGHTS:  The Embedded Software is subject to U.S. export
control laws, including the U.S. Export Administration Act and its associated regulations, and may be
subject to export or import regulations in other countries. You agree to comply strictly with all such
regulations. You confirm that with respect to the Embedded Software, you will not export or re-export it,
directly or indirectly, to any countries that are subject to U.S. export restrictions. Use, duplication or
disclosure by the U.S. government is subject to the restrictions as set forth in the Rights in Technical Data
and Computer Software Clauses in DFARS 252.227-7013(c)(1)(ii) and FAR 52.227-19(c)(2) as applicable.
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GETTING STARTED
The Panasonic X800 GSMTM/GPRS mobile phone operates on Global System for 
Mobile Communications (GSM) networks around the world, which provide integrated 
voice mail, text short message service (SMS), multimedia messaging service (MMS), 
fraud protection and superior voice quality.

Feature Availability
Some features are network dependent or are available only if you subscribe to the 
feature. Some functions are SIM card dependent. Note that before you can use or 
activate many of the network features, you must subscribe to the desired services. For 
more information, contact your wireless service provider.

Before Using Your Phone
The SIM card must be installed in your phone for it to operate on the cellular network. 
Insert SIM card, then attach battery and fully charge it.

INSTALLING AND REMOVING SIM CARD

Installing SIM Card
1. Use fingernail at base of triangle mark on battery cover 

to gently slide cover until cover clicks and moves slightly 
. Then, lift cover to remove . Remove battery (see 

page 8). 

2. Position SIM card as shown, with gold contacts facing 
phone and notched corner entering phone first. 
Carefully slide the SIM card into the SIM card pocket 
until card is all the way seated.
• If SIM card is inserted incorrectly or damaged, 

Insert SIM card may display. Remove SIM card 
then install again.

• If SIM card rejected message appears, contact 
your wireless service provider.

Caution: This product contains small parts. Keep out of reach of small children.
Take care not to scratch or bend SIM card and gold contacts.

Note: Refer to the label in the battery compartment 
for location of SIM card pocket and notched 
corner area.
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Removing SIM Card
1. Use fingernail at base of triangle mark on battery 

cover to gently slide cover until cover clicks and 
moves slightly. Then, lift cover to remove. Remove 
battery and remove battery (see page 8).

2. Place finger on bottom edge of SIM card and gently 
slide out.

INSTALLING AND REMOVING BATTERY

Installing Battery
1. Hold battery at 45º angle; insert tabs on top edge of 

battery into slots along top edge of battery area .
2. Push bottom of battery down until it fits .
3. Replace battery cover by sliding cover. Cover clicks 

when if is correctly shut and should fit snugly with no 
gaps.

Removing Battery

1. Remove battery cover. Use fingernail at base of triangle mark 
on battery cover to gently slide cover until cover clicks and 
moves slightly. Then, lift cover to remove.

2. Use fingernail to pull tab at bottom left of battery to lift and 
remove battery.

Note: If you are upgrading your phone and your previous phone did not support new 
services, such as MMS (Multimedia Messaging Service), you may need to insert 
a new SIM card. Contact your wireless service provider. 

Caution: Using non-Panasonic accessories or accessories not recommended by your 
wireless service provider may result in poor performance of your phone, or 
even cause an electrical hazard.

Note: Before you remove the battery, switch off the phone and disconnect 
the phone from the charger or any other device.
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CHARGING BATTERY

1. Open connector cover at left side of phone as you turn over and upside down 
phone.

2. Insert connector. Connect charger into mains power socket.
3. When charging is complete, remove from mains power 

socket. You should press and hold release buttons on 
both side of connector end and pull gently to disconnect 
the charger from phone.

• DO NOT force connector: it may damage phone or 
charger.

Charging Icons on Main and External Display
 bars scroll when charging

bars stop scrolling when charging is complete

• If the phone is switched on, Battery full message appears when charging is 
complete.

Low Battery Warning
When the battery power is low, Battery low displays and a warning tone sounds; phone 
will automatically switch off. Fully recharge the battery. If you receive the low battery 
warning during a conversation, finish your call immediately.

Note: First verify that battery is installed. 
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INSTALLING AND REMOVING miniSD CARD
The miniSD Card is a memory card used to expand phone memory and a way to 
transfer files to other devices.

Installing miniSD Card
1. On left side of phone as you turn over and upside down 

phone, lift up miniSD Card cover . 
2. Slide miniSD Card with notched corner entering phone 

first and gold contacts facing down into the miniSD Card 
pocket until it clicks. Push down miniSD Card cover until 
it clicks .

Removing miniSD Card
1. Press Power key , scroll to Eject miniSD Card and press OK. Before removing 

miniSD Card, wait for file saving or copying process to finish.
2. On left side of phone as you turn over and upside down 

phone, lift up miniSD Card cover. 
3. To release miniSD Card, gently push bottom edge of 

miniSD Card forward into pocket . 
4. After miniSD Card is ejected, gently remove it . Push 

down miniSD Card cover until it clicks.

Note: Do not insert any object except a miniSD Card into the miniSD Card pocket.
Do not place labels, etc., onto the miniSD Card. A fine difference in card thickness 
may result in insertion or removal difficulty, loss of contact or loss of data.
Take care not to scratch or bend miniSD Card and gold contacts.
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PHONE OVERVIEW
  

Earpiiece

Main Display

Navigation Key

Left Softkey
Clear Key
End Key
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Power Key
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Browser Key
Asterisk Key
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External Display 
and Viewfinder
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KEY FUNCTIONS
Key Function

Power Key
Press and hold to switch phone on or off.
Press to choose different ringtones, eject miniSD Card, lock keypad, or lock the 

phone.

Navigation Key
Press outside edges to scroll up , down , left  or right  to move through 

menus and text. 
Press centre  to select option.
In standby mode, press centre  to open Contacts.
Take a picture in Camera mode by pressing .

Send Key
Make a call.
Press in standby mode to recall recently dialled numbers. Scroll  to see received 

and missed calls lists.
Press and hold in standby mode to activate voice commands.

End Key
Ends a call.
Return to standby mode.

Applications Key
Enter the main applications menu area.
Return to standby mode.
Press and hold to view currently open applications.

Left Softkey
Perform action named in lower left of display.
Shortcut to open preset application in standby mode. To change shortcut, see 

page 95. 
To lock the keys, in standby mode press , then press . To unlock the keys, 

press , then press .

Right Softkey
Perform action named in lower right of display.
Shortcut to open preset application in standby mode. To change shortcut, see 

page 95.

Edit Key
Select Dictionary for predictive text including insert and edit words, or alpha mode or 

number mode.
Insert numbers or symbols. 
Change writing language. 
Mark multiple items in a list by holding down , then scrolling  or .
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Symbols used in this manual   

Clear Key
Erase character in edit mode.
Delete highlighted entered item.

Browser Key
Opens Browser.

Asterisk Key
In standby mode, press and hold to switch PhotoLight or flashlight on or off.
In numeric and standby modes, press repeatedly for *, +, p and w characters.
In Dictionary mode, scroll to other word choices when word is underlined.
In edit mode, press to open special character table.

Zero Key
In standby mode, press and hold to enter + character for dialling.
In edit mode, enter space.

Silent Mode Key
In standby mode, press and hold to switch Silent mode on/off.
In edit mode, shift to upper and lower case letters, or press twice briefly to turn on/off 

Dictionary for predictive text.

Multibutton (on side of phone)
For external display, press once to switch on backlight, then press as needed to 

toggle between clock and icon views.
Turns off ringer during incoming call.
Takes a picture in Camera mode when flip is closed.

Press Power key. Press Applications key.
   Press outside edges of navigation 

key to scroll up, down, left or right 
to move through menus and text.

Press navigation key centre.

Press Send key. Press End key.
Press Left softkey. Press Right softkey.
Press Edit key. Press Clear key.

 - Press number keys. Press Browser key.
Press Asterisk key. Press Silent Mode key.
Press Multibutton key (on side of 
phone).

Key Function
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ICONS
Different icons appear depending on the features you are using and the options you 
have selected.  

Icon Indicates Icon Indicates

Seven levels indicate battery charge 
level. Bars scroll when battery is 
charging.

Alarm is set

Seven levels indicate signal strength 
from network on which phone is 
currently registered

New voice mail message received (if 
you have 2 lines, left circle is 
darkened for line 1, right circle is 
darkened for line 2)

GPRS service is available New message received

GPRS service is on hold during 
voice call

Message in Outbox waiting to be 
sent

GPRS connection is active Bluetooth is enabled

Multiple GPRS connections are 
active Bluetooth is active

Missed call Infrared is enabled (flashes when 
active)

Call divert is active (if you have 2 
lines, 1 or 2 also appears) USB connection enabled

Line selection 2 
(SIM card dependent, if you have 2 
phone lines)

Navigation key - scroll and move up 
or down options

Data call Navigation key - scroll left or right, 
move left or right to view tabs

Keypad is locked All ringing tones/ring volume are off 
(Silent ringtone)

Earpiece sound on Private handsfree headset attached

Loudspeaker sound on
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STANDBY MODE DISPLAYS

MAIN DISPLAY

EXTERNAL DISPLAY

Press Multibutton once to switch on backlight, then press as needed to toggle between 
clock and icon views.
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PHONE BASICS AND MANAGING CALLS
SWITCHING THE PHONE ON AND OFF
Press and hold .

MAKING CALLS
Check that phone is switched on, signal strength icon displays at least one bar , and 
your network operator logo displays before dialling a call.

Type in the Phone Number to Dial
1. From standby mode, enter the area code and phone number, and press .
2. To end the call, press .   

Use a Contact Card to Dial
From Contacts application:
1. Scroll to desired name card, press .

• If the card has several phone numbers stored, select the one you wish to dial.
To add information to your Contacts, see page 30.

Use a SIM Directory Entry to Dial
From Contacts application:
1. Scroll  to SIM directory view.
2. Scroll to desired name, press .

To add names and numbers to your SIM directory, see page 30.

Note: If your SIM card is PIN protected, your PIN code will be requested. 
Enter the PIN code and press OK. See Security Settings on page 99.

Note: To erase a digit, press .
During a call, scroll  or  to adjust earpiece volume.

Warning: Closing the flip during a call will end the call, when set to default. 
To set the phone to keep the call connected when you close the 
flip, see Active clamshell in Call Settings on page 95.
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Speak the Name to Dial
To dial by saying the name of the person you wish to call: 
1. Press and hold . 
2. After the prompt to “Say a command”, say “Voice Dial”.
3. After the prompt to “Say the name or number”, say the full name of a person in your 

Contact list, including first name and last name.
4. The name is repeated, and the phone will begin dialling.

See page 107 for more Voice Command options.

Speed Dialling
If you assigned speed dialling keys (see page 106) to your frequently called numbers, 
you can dial them with 2 key presses.
1. From standby mode, press the preset speed dial digit key  -  then press 

.
• If Speed dialling is set to On, (see Call Settings on page 95), just press and hold 

the preset speed dial digit key to dial the assigned number.

Dialled Numbers, Received, or Missed Calls List
You can quickly dial previously dialled numbers, received call numbers, or numbers of 
calls you missed.
1. From standby mode, press .
2. From the list of Dialled numbers, scroll to desired entry and press  to dial.

• Scroll  to move to Received calls tab and Missed calls tab to select a number 
from either of those lists.

Automatic Redial
If you set Automatic redial to On in the Call Settings menu (see page 95), your phone 
will automatically redial the number up to 10 times under certain conditions, such as no 
answer, destination number is busy, network busy, or some connection errors.
Press Quit or  to stop automatic redialling.

Dial from Messages
If a received message contains a phone number, you can dial it from the Inbox 
message. You can also call the sender of an SMS text message.
From Messages application:
1. Open Messages. Scroll to Inbox and open.
2. Scroll to desired message and open. 

Note: Location number 1 may be reserved for voice mailbox number.
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3. To find the phone number within a message, press Options and select Find > 
Phone number, E-mail address, or Web address. When found, text and numbers 
will be underlined.
• To call the sender of SMS text message from the open message, press  to 

dial the sender’s phone number.

International Calling
From standby mode, press and hold  to enter +, the international prefix, which is a 
shortcut for international dialling access. Then type in the country code, area code, and 
phone number. Press . 

Emergency Calls
Dial the local emergency number used in your current location.
1. Switch on the phone if it is off.
2. Verify that the antenna icon is displayed.
3. Enter the local emergency number (such as 112) and press . 

Send Service Command to Network
Ask your wireless service provider to activate a particular service by sending a service 
command. These commands, which may be called USSD commands, can activate 
services such as mobile prepay and chat.
1. First, contact your wireless service provider for the proper service command code.
2. Type in the supplied service command code. If the phone recognises it as a 

supplementary service or USSD request, press Send service comm.

ANSWERING CALLS
When there is an incoming call, the phone rings and flashes green.

1. Open flip to answer a call.
• If flip is open, press  to answer a call.

Note: Many countries/regions include an initial 0 in the area code. In most 
cases, you should omit this when dialling international numbers. For 
further help, contact your wireless service provider.

Note: You can call the local emergency number even if the keys are locked.
Making emergency calls without SIM is country or network operator dependent.

Note: If the phone is set to a ringtone with vibrating alert on, the phone 
flashes green and vibrates instead of ringing.
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Mute Ringing Tone
To mute ringing tone, press  if flip is closed. If flip is open, press Silence . Then 
answer the call by pressing .

Change Answer Settings
To change the setting so a call will not be answered by opening the flip, see Active 
clamshell in Call Settings on page 95.

To answer by pressing any key except , , or , see Anykey answer in Call 
Settings on page 95. 

Divert Incoming Calls
To divert calls to your voice mailbox or another number, see Call Divert on page 102. 
Then you can press  or Reject softkey and incoming calls will be diverted.
If you ignore the call by not pressing any keys, the call details appear on the Missed 
calls list.

ACTIVE CALL OPTIONS
When on a call, you can put the call on hold, mute the microphone, send touch tones for 
passwords, etc., and create multi-party calls, depending on network support.

Place Calls on Hold
To put a call on hold or release the call from hold, press Options and select Hold or 
Unhold.

If you are connected to 2 calls (an active call and a call on hold), press Options and 
select:   

Swap Put active call on hold and activate held call.
Transfer Connect an active call and held call, or incoming call to active or 

held call, and disconnect yourself from both calls, leaving the 
two callers to talk to each other.

Shortcuts: You can also press  to switch between Hold and 
Unhold on one call, or switch between one active and 
one held call (Swap). 
To end a held call and continue with the active call, 
press  and .
To end the active call and continue with the held call, 
press  and .
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HANDSFREE TALKING
To hear the caller’s voice from the handsfree loudspeaker, press Loudsp.. Set the 
phone down nearby so you and several others can have a conversation without holding 
the phone. 
To go back to the earpiece, select Handset.

If you have activated a Bluetooth handsfree headset, press Options and select BT 
Accessory to hear the caller’s voice in the Bluetooth headset.

Volume Control
Scroll  or  to increase or decrease volume of phone earpiece , phone 
loudspeaker , or if a headset is attached. Note the volume step bars change as you 
adjust volume.
To mute or unmute the microphone, press Options and select Mute or Unmute. Mute 
switches off microphone of phone and any accessory microphones if attached. Unmute 
switches microphone back on.

CALL WAITING
If you activated Call waiting network service in Call Settings (see page 95), you can 
answer an incoming call when on an active call.
1. During an active call, press  to answer an incoming call. The active call is put on 

hold.
• To switch between the calls, press Swap or .
• To end the currently active call and answer the incoming call, press Replace.

2. To end the currently active call, press . The held call becomes active.
• Or to end both calls at once, press Options and select End all calls.
• If you press and hold , all calls and data connections are ended.

To reject the incoming call, press Reject. The caller receives a busy message or goes to 
voice mail.

Send DTMF Touch Tones
DTMF touch tones can be transmitted during a call just by pressing the keys (0 to 9, #, *) 
on your phone. Touch tones are often used to access services such as voice mailboxes, 
calling card calls, and banking. 

During a call, press Options and select Send DTMF if you stored a DTMF touch tone 
sequence in a Contacts card. Press Find, scroll to desired entry and select. 

Loudspeaker icon -- handsfree is active.

Earpiece icon -- handsfree is not active.
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To dial or store touch tone sequences:
1. Type in access phone number.
2. Before entering touch tone digits, press  repeatedly to scroll through *, +, p and 

w characters to insert:
• a short pause before the digits are transmitted (p character).
• a manual wait period (w character) that requires you to press Send  during 

the call to transmit the digits.
• + character to send a touch tone sequence stored in a speed dial location (see 

page 106).
3. Enter the touch tone digits, for example, the access codes for your voice mailbox.
4. Press  to immediately dial call, or press Options and select Add to Contacts to 

store sequence in your Contacts (see page 30).

Open Applications During a Call
During a call, open the main application menu by pressing , then open the desired 
application, for example, check your Calendar for an upcoming meeting time. The active 
call remains connected and is indicated by a small pop-up window. To return to the 
active call window, exit the application.

If you press , an active call will always disconnect.

Play/Record Sound Clips During a Call
To play a sound clip during a call, open the sound clip from its current location and play. 
The other person hears the sound clip.
To record the current call, see page 114.

Multi-Party Calls
In a multi-party call, you can have a conversation with up to 5 different parties at the 
same time if supported by the network.
1. Call the first party.
2. After the call is connected, press Options and select New call to enter a number or 

press Find to go to the Contacts to dial a number and press . The first call is put 
on hold.

3. After the new call is answered, press Options and select Conference to join the 
held call and the active call together. From then on, there is only one active call, 
which is the multi-party call.

4. To add another party to the call, repeat step 2, then press Options and select 
Conference > Add to conference.

Note: You can enter multiple instances of pause, wait, and speed dial 
characters and touch tone sequences.
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5. To have a private conversation with one of the parties, press Options and select 
Conference > Private. Scroll to desired party and press Private. The separated 
party becomes the active call on your phone, the multi-party call is put on hold; 
however the remaining callers can continue with the multi-party call. To return to 
multi-call, press Swap. To return Private call to multi-call, press Options and select 
Conference > Add to conference.

6. To drop a party from the multi-party call, press Options and select Conference > 
Drop participant. Scroll to desired party and press Drop. 

7. To end the multi-party call, press . 

ENDING CALLS
There are several ways to end a call:

• Close the flip.
• Press .
• Press End call softkey.
• Press Options and select End active call.

To end all calls if there are more than one:
• Press Options and select End all calls.

If you press and hold , all calls and data connections are ended.

See Active Call Options starting on page 19 for ending held calls, waiting calls, and 
multi-party calls.

CLOSE THE PHONE DURING A CALL
Closing the flip clamshell ends the call. This is the default setting for Active clamshell 
in Call settings. If you want to close the phone and speak handsfree during a call, 
change the Active Clamshell setting to Off. This setting switches the caller’s voice to 
the back loudspeaker so you can speak handsfree.

To keep calls connected when you close the flip clamshell and prevent calls from being 
answered when the flip is opened, see Active clamshell in Call Settings on page 95.

Note: If you are on an active call and already have a held call, start at step 3.
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ENTERING TEXT
There are two main ways to enter text; using the predictive text dictionary to quickly 
enter words, or alpha mode in which each key is tapped until the planned letter appears.

DICTIONARY FOR PREDICTIVE TEXT ENTRY
Dictionary uses a predictive text system to enter words by pressing one key per letter to 
display the planned word, instead of pressing keys multiple times until each planned 
letter appears. 

For example, to enter “Call me.” in a message, press:

                        
C a l l m e .

When you press the 6 key and the 3 key, the word “of” appears on screen, because the 
English dictionary ranks “of” as the most common word associated with the key presses 
6 and 3. To change the word “of” to “me”, press  once, and the word changes.

DISPLAY PLANNED WORD MATCHES
If the correct word does not display, press  repeatedly to scroll through an alternate 
word list. To choose from all the word matches, press  and select Dictionary > 
Matches.

ADD WORDS TO PREDICTIVE TEXT DICTIONARY
To add a word that is not already in the dictionary, press  and select Dictionary > 
Insert word. You can also add the word to the dictionary when Spell softkey appears.

GENERAL TEXT ENTRY
Enter text and numbers in one of three ways: 

Alpha mode - press each key repeatedly until planned letter appears

Dictionary mode - press one key per letter for dictionary to display planned word

Numeric mode - enter numbers 

In both alpha mode and dictionary mode, choose from:
First letter capital All capitals
Lower case

Shortcut: To enter numbers while in alpha or dictionary mode, press and hold 
desired number key  - .
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To enter symbols, press  and select Insert symbol.

To enter text at a flashing cursor:
1. Press the number keys associated with the planned letters repeatedly until the 

planned letters appear on screen. 
• To enter text using the predictive text dictionary, press  and select Dictionary 

on, if it is not already active.
2. Editing actions for each key and shortcuts:

Cut, Copy, and Paste Text
1. To cut, copy, and paste text, move cursor to left of text you wish to copy. 
2. While holding down , press and hold  to highlight text.
3. Release keys to stop highlighting. 
4. Press  and select Cut or Copy. 
5. In message field, move cursor to new desired location, press  and select Paste.
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NAVIGATING THE APPLICATIONS
To view the main applications window, press .

Navigation Key
Press the left, right, top and bottom edges of the navigation key to move around 
the display. 

Press  to:
• Open an application item
• Select a highlighted item
• Confirm a selection
• Take a picture with the camera

If an up or down arrow appears at the bottom of the display, scroll  or  to go to 
additional items.  

Tabs
There may be more files, folders, or pages associated with an 
application item, which can be viewed by moving right and left 
across the screen. This is indicated by tabs ,
arrows , or numbers near the top of the screen. For example,
if you are viewing page 5 of 12 pages associated with a file, 5/12 
and arrows are displayed.
• Scroll  and  to move through the tabs and pages. 

Condensed Instructions
In this guide, to condense wording, statements are used such as “Press Options and 
select Open.” This means to press Options, highlight Open, and press Select. You 
may need to scroll within the menu to reach Open. Many menu items are available 
within Options menus and other menus, thus these shortcut statements will be used 
throughout the guide to indicate the same type of process.

Shortcut: To jump to and open one of the first 9 application items (if you have not yet 
scrolled), simply press the number key corresponding to the desired item’s 
location on the grid view. The grid view numbering system is: 

1 2 3

4 5 6

7 8 9
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In this guide, a statement such as ‘Select Send > Via multimedia’, means to scroll to 
Send, then scroll  to view the pop-up menu containing Via multimedia, then press 

 or Select softkey to select Via multimedia. Within the pop-up menu, you may need 
to scroll to highlight Via multimedia.
To streamline this guide, some of the basic options are not included in every table.

Options Softkey
At the first level of each menu item, Options  appears as a way to organise or 
customise the menu system. The options change depending on the menu level you are 
viewing.

To open the Options menu:
• Press Options, scroll to highlight the desired action, then press  or press Select. 

These additional actions may be available in the Options menu:

Mark/Unmark
In menu items containing many files, you can mark specific files in which to perform an 
action. For example, you may wish to delete 5 images from your Images folder 
containing 29 images.

To mark an item or items:
1. Press Options and select Mark/Unmark > Mark to place a checkmark next to the 

desired file. Scroll to mark more items as needed, or select Mark all to mark all files.
2. Press Options, then select desired action such as Delete, Send, Move.

Open Open the item.
List view View the menu items in a list form. If you select this, the option 

changes to Grid view to view the menu items in a grid form.
Move Move the item to another place within the application system.
Move to folder Move the application item into a folder.
New folder Create and name a new folder.
Memory details > View information about items stored in the phone memory and 

memory card (also referred to as miniSD Card).
Exit Exit the menu item.

Remove or Delete Remove or delete an item or a marked item (see Mark/Unmark 
on page 26) on a list or grid, or press .

Rename Give a new name to the item.
Edit Change information you have already entered.
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To unmark an item or items:
1. Press Options and select Mark/Unmark > Unmark on a marked file to remove the 

checkmark. To unmark all files, select Unmark all. 

Menus within a Menu
A pop-up menu appears when more than one choice is available. 
For example, you can send a Contacts entry several ways: via text 
message, via multimedia, via e-mail, via Bluetooth, and via 
infrared. 

To enter a pop-up menu:
• Scroll , or press , or Select softkey.

To close a pop-up menu:
• Scroll , or press Cancel softkey.

Save Changes
In many cases when editing text or numbers, or changing a setting; press the Back 
softkey to automatically save changes.

MULTITASKING
You can work with more than one menu item simultaneously. For example, you can start 
creating a new message, rename an image, and begin creating a Contacts entry, all 
without losing the data you have already entered.

To keep a menu item open:
Press  to go to the standby screen. Pressing  does not close the open menu 
item. 

Opening and closing menu items
There are several ways to open menu items:
• Press .
• Press Options and select Open.

Shortcuts: To mark or unmark an item, hold down  then press .

To mark or unmark multiple items, hold down  then press and hold  or  of 
navigation key to scroll through desired items. Release  or  to stop marking.

Note: During a phone call,  terminates the call instead of acting as 
a shortcut to the standby screen.
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There are several ways to close menu items:
• Press Options and select Exit.
• Press Back until Exit softkey appears, then press Exit.
• Press Close.

Shortcut to swapping among open items
If you have several menu items open, you can press and hold  
to view a pop-up window and scroll to locate the desired open item. 
When you open the item, you will begin at the point where you 
were previously.
To close an open item from the pop-up window, scroll to desired 
item, press  and select Yes.

SEARCH OPTION
In certain menu items, a magnifying glass icon  
appears which allows you to search for a name, file or item.
To search, enter the first letter of the desired name or file. The phone finds and displays 
matching entries. To refine the search, enter two or more letters.

SHARED PHONE MEMORY
The phone’s memory capacity is shared by all images; text, multimedia and e-mail 
messages; Contacts cards; video and sound clips; ringtones; Calendar and Notepad 
notes; and downloaded applications stored on your phone. If you keep more files on the 
phone, then there is less memory available to store new files or run certain applications.
To decrease the amount of phone memory used: (1) store data on your miniSD Card; (2) 
delete data that is old, copied elsewhere or not being used; (3) delete messages with 
attachments from your Inbox after saving attachments to an application; (4) use the 
portrait format to take pictures with the Camera whenever possible. The portrait format 
file size is much smaller than standard format.
To view details of the phone memory and miniSD Card use, and amount of free 
memory: 
1. Press .
2. Press Options. 
3. Scroll to Memory details.
4. Then scroll  to choose phone memory or memory card (also referred to as miniSD 

Card).
Also see File Manager on page 119.
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APPLICATIONS MENU MAP
The phone’s main application menus are listed below. The names listed represent the 
names in list view. The names may be slightly different in grid view.      

Note: The menus may not appear in the order or with the same icons as listed here. 
The order and icons vary according to your wireless service provider, or if you 
have customised your settings.

  Settings   Camera   Tools
Ringtone Profiles
Themes
Settings
Clock
Speed Dialing
Voice
PrintBoy Setup
About product

Calculator
Converter
Notepad
Voice recorder
miniSD Card
To-Do List
Application Mgr
File manager
PhotoLight
SIM Tool Kit 

(optional)

  Calendar   Contacts   Media
Media Gallery
PhotoBase
RealOne Player
Video Recorder

  Messages   Call Logs   Connectivity
Voice mailbox
Messages

Recent calls
Call duration
GPRS counter

Browser
Operator Menu
Modem
Bluetooth
Infrared
USB
Connection Mgr
SyncML
Device Mgr

  Games   Favourites   Quickoffice
MicroGolf
Balloon-Headed 

Boy
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CONTACTS
Store names, phone numbers, e-mail, web and street addresses, even a thumbnail 
picture in a Contact card. Call and send messages directly from Contacts. Numbers can 
also be stored on your SIM card. See Entering Text on page 23 to learn how to enter 
text.

CREATE NEW CONTACT CARDS
From Contacts application:
1. Press Options and select New contact.
2. Enter information in main fields:

Last name Telephone
First name Mobile
Company Fax
Job title E-mail

3. From main fields, press Options to: 

4. Press Done to save entry.

SIM DIRECTORY
The SIM Directory shows you the names and numbers stored on your SIM card. Your 
wireless service provider can program their service numbers, your wireless phone 
number and other numbers into your SIM card. You can store personal numbers on your 
SIM card as well. 

Unlike a Contacts entry, a SIM Directory entry consists of only one name and one phone 
number.

Copy Numbers to SIM Directory
1. From the Contacts list, highlight the desired card.
2. Press Options and select Copy to SIM direct.
3. Choose one of the phone number fields to copy, press OK.

Add thumbnail Place picture from your Images folder into the card.
Add or Delete detail Choose desired fields and icons from list including Job title, Tele-

phone, Tel. (home), Tel. (business), 3 mobile, 3 fax, pager num-
bers, 3 E-mail fields, 3 Web addresses, 3 street address fields, 
DTMF tones, Birthday, and Note.

Edit label Change the field name.

Note: See SIM Directory to create and copy entries into your SIM Directory.
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• If you select All, the phone creates a separate SIM directory entry for each phone 
number stored with that Contacts entry name.

Create and Manage SIM Directory Entries
1. From the Contacts list, scroll  to SIM directory tab.
2. Press Options and select from:    

FIND A CONTACT CARD
From Contacts application:
1. Scroll to desired entry, or enter the first letter of desired entry in . Entries 

beginning with that letter will display.
2. Press  to open entry.

MAKE A CALL
From Contacts application:
1. Scroll to desired Contacts entry and press .

Or, press Options and select Call.
• If entry contains more than one number, choose desired number to dial before 

pressing . 

Note: To copy SIM entries to your Contacts, highlight the desired SIM entry, then press 
Options and select Copy to Contacts.
The first time Contacts is opened after a different SIM card is placed in the 
phone, press OK if you wish to copy SIM contacts into the Contacts memory.

Call Call the highlighted entry.
New SIM contact Create a new SIM contact entry. Open and enter Name, then 

enter No. and press Done.
Edit Edit the highlighted SIM entry. Numbers stored by your wireless 

service provider cannot be edited.
Delete Delete the highlighted SIM entry. Numbers stored by your wire-

less service provider cannot be deleted.
Copy to Contacts Copy the highlighted SIM entry to your Contacts list.
My numbers View your own phone numbers.
SIM details View the number of used and free SIM entries.

Note: To make a call from the SIM directory, from Contacts application scroll  to 
SIM directory tab. Scroll to the desired entry and press .
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CREATE A MESSAGE
From Contacts application:
1. Scroll to the desired Contacts entry and press Options.
2. Select Create message > Text message, Multimedia message, or E-mail.
3. To complete Text messages, see page 42; or Multimedia messages on page 42; or 

E-mail messages on page 44.

EDIT CONTACT CARDS
From Contacts application:
1. Highlight desired Contacts card.
2. Press Options and select Edit.
3. Scroll to desired field to edit, begin entering data. If the field already has information, 

scroll  to move to editing point, press  to clear a letter or digit.
4. Press Options to:

5. Press Done to save entry.

Assign Default Number to Dial
For a Contact card, set a particular phone number or address that the phone will use 
each time you wish to call or write messages to that person.
From Contacts application:
1. Scroll to desired Contact card and open.
2. Press Options and select Defaults.
3. Highlight a field:

Phone number
Text msg. number
MMS number/address
E-mail address

4. Press Assign.
5. Scroll to the desired entry and press Select.

• Repeat steps 4 to 6 to assign default numbers to the other fields.

Add thumbnail Place picture from Images folder in phone memory or miniSD 
Card.

Add or Delete detail Choose desired fields and icons from list including Job title, Tele-
phone, Tel. (home), Tel. (business), 3 mobile, 3 fax, pager num-
bers, 3 E-mail fields, 3 Web addresses, 3 street address fields, 
DTMF tones, Birthday, and Note.

Edit label Change the field name.

Note: To remove a default assignment, select (no default).
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Assign a Ringing Tone
From Contacts application:
1. Scroll to desired Contact card and open.
2. Press Options and select Ringing tone.
3. Scroll to desired tone (after a brief pause tone will play). You can use tones already 

supplied; sent in messages (see page 46); downloaded (see page 77); or recorded 
(see page 113).   

To assign a ringing tone to a group, scroll  to move to Groups tab, scroll to desired 
group, and continue with step 3.

Assign Speed Dial
From Contacts application:
1. Scroll to desired Contact card and open.
2. Scroll to desired phone number field in which to assign the speed dial key, press 

Options and select Assign speed dial.
3. Press or scroll to desired number key and press Assign. An icon  denotes that a 

speed dial key has been assigned to this number field.

To make a call using speed dial, press the associated number key, then press .

To remove an existing speed dial key, from Contacts application:
1. Scroll to desired Contact card and open.
2. Scroll to speed dial phone number field, then press Options and select Remove 

speed dial.
See page 106 for speed dial options.

Go to Web Address
If a Contact card contains a web address, you can launch the Browser and go directly to 
the web address.
From Contacts application:
1. Scroll to desired Contact card and open.
2. Press Options and select Go to web address. 

Note: If tones do not play, change the phone’s ringtone to General 
or Outdoor to hear the tones.
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MANAGE CONTACTS LIST
From Contacts application:
1. Press Options and select Edit, Delete, or Duplicate.

Memory Used in Contacts
To view number of cards, groups used and amount of memory used, from Contacts 
application:
1. Press Options and select Contacts info > Memory.

Sort List by Last Name or by First Name
From Contacts application:
1. Press Options and select Settings.
2. Open the Name display field to sort the list either by Last name first or First name 

first.

SEND A CONTACT CARD
Before a Contact card can be sent by Messaging or to another device, it is converted to 
an electronic business card format known as vCard.
From Contacts application:
1. Scroll to desired Contact entry.
2. Press Options, scroll to Send > Via text message, Via multimedia, Via e-mail, 

Via Bluetooth, or Via infrared.
3. To complete text messages, see page 42; or multimedia messages on page 42; or 

e-mail messages on page 44; or Bluetooth on page 83; or Infrared on page 85.

SERVICE NUMBERS
If your wireless service provider has stored service numbers on your SIM card, you can 
view and call the service numbers.
From Contacts application:
1. Press Options and select Service numbers.

CREATE AND MANAGE GROUPS
Place Contact entries into one group. Select the group name when addressing a new 
message, and your message is sent to each member of the group. For example, set up 
Business or Family group. See Messages starting on page 40 to learn how to send 
messages.

Note: See Mark/Unmark on page 26 to select more than one entry. 

Note: This feature is not available if the phone contains Chinese language.
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Create New Group
From Contacts application:
1. Scroll  to Groups tab.
2. Press Options and select New group.
3. Enter a name for the group and press OK.
4. Open the group name, press Options and select Add members.
5. Select desired Contact cards to add.

• To remove a member from a group, scroll to desired name, then press Options 
and select Remove from group.

Manage Groups
From Contacts application:
1. Scroll  to Groups tab.
2. Scroll to desired group, then press Options and select from: Open to view group, 

Delete group, Rename group, add Ringing tone for group.

To see if a person belongs to a group; or add a person to a group, from Contacts 
application:
1. Scroll to desired Contact card.
2. Press Options and select Belongs to groups or Add to group. When adding, 

select desired group and press Add.

TAKE A PICTURE AND ADD TO CONTACT CARD
From Camera application:
1. The main display acts as a viewfinder when the flip is open. The external display 

acts as the viewfinder when the flip is closed.
2. To snap the picture, press  if the flip is open. Or press the Multibutton  on the 

side of the phone if the flip is closed.
• The image is saved in your Images folder in Media Gallery.

3. Open Contacts.
4. Highlight desired Contacts card.
5. Press Options and select Edit.
6. Press Options and select Add thumbnail.
7. Select Phone memory.
8. Open Images folder. Scroll to highlight the image and press Select.
9. Press Done.
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CALENDAR
Keep track of upcoming meetings, appointments and special dates. Set alarms to 
remind you of upcoming events. Calendar events can be sent and received as 
vCalendar messages and synchronised with other devices to keep track of your 
schedule.

CREATE CALENDAR EVENTS
From Calendar application:
1. Press Options and select New entry > Meeting -- events with a start and end time, 

Memo -- events such as trips or vacations, or Anniversary -- single day events 
such as birthdays and anniversaries.

2. Enter information in most fields by entering numbers or letters:

3. Press Done to save event.

Set Calendar Alarm
When you set the alarm to On, scroll  to set the alarm time and date.
When the alarm rings, press Stop  to stop the alarm. Press Snooze  or any 
other key to snooze the alarm. 

Set Event Repeat Cycle
When an event occurs regularly; for example, baseball practice or music lessons, open 
the Repeat field to set interval time periods such as Weekly or Monthly.

Meeting Memo Anniversary
Subject Subject Occasion
Location Start date Date
Start time End date Alarm
End time Synchronisation Synchronisation
Start date
End date
Alarm
Repeat
Synchronisation

Shortcut: If you start typing after opening the Calendar, you are 
automatically entering the subject in a Meeting entry.

X800_China_OI.book  Page 36  Tuesday, November 16, 2004  11:25 AM



   37

Set Synchronisation
If you synchronise your Calendar events with a PC, you can set the privacy level.
• Set to Private to hide events from online viewers. 
• Set to Public to allow online viewers to see the event.
• Set to None if you do not wish to synchronise the event with your PC calendar. See 

Synchronisation on page 86.

BROWSE CALENDAR
View the calendar by day, by month, or by week.
To change view, press Options and select Month view or Week view.

CALENDAR ICONS
 Memo Anniversary in Day and Week views

Month View
Scheduled note Triangle in the lower right corner of a date.

Red -- private synchronisation.
Blue -- public synchronisation.
Light red -- none.
Purple -- more than one entry for the date.

Current date Underlined.
Selected date Boxed; date also appears in the navigation 

bar.
Far left column The year’s week number (see Week view title in Calendar 

Settings).

Shortcuts: Scroll     to move around the calendar.
Press Options and select Go to date to go to a desired date.
Press  to go to today.
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Week View
Days of the week are displayed in columns. Each hour of a day is 
denoted by a cell.
Meeting notes A bar during the scheduled time periods.
Memo icons Appear between 7am and 8am
Anniversary icons Appear between 7am and 8am
Current weekday Underlined (if you are viewing the current 

week).
Selected date Boxed; date also appears in the navigation bar.
Screen title Either the week number or the week dates of the current week, 

depending on Calendar setting.

Day View
To view a certain day, scroll to the date and open.
Scheduled events are listed.

EDIT CALENDAR EVENTS
1. Scroll to desired date in any view and open.
2. Scroll to scheduled event and open. Edit desired fields.
3. Press Done when finished.

DELETE EVENTS
1. Scroll to desired date in Month or Week view, and time period in Week view and 

open.
2. Press Options and select Delete or press .

To delete multiple events:
1. View the calendar in Month view.
2. Press Options and select Delete entry > Before date to delete entries before your 

specified date, or All entries.
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CALENDAR SETTINGS
From Calendar application:
1. Press Options and select Settings. Open each option:  

SEND CALENDAR EVENTS
Before a Calendar event can be sent by Messaging or to another device, it is converted 
to an electronic scheduling exchange format known as vCalendar.
1. From an open Calendar event in Day view, press Options and select Send > Via 

text message, Via multimedia, Via e-mail, Via Bluetooth or Via infrared.
2. To complete text messages, see page 42; or multimedia messages on page 42; or 

e-mail messages on page 44; or Bluetooth on page 83; or Infrared on page 85.

CHINESE LUNAR CALENDAR
Check Chinese Lunar Calendar dates and festivals when still viewing western Calendar 
information.

To display Chinese Lunar Calendar information:
1. From the open Calendar, press Options and select Settings.
2. Scroll to Lunar calendar. 
3. Select On.
4. To view Chinese Lunar Calendar detail, press Options and select View lunar data.

To turn off Chinese Lunar Calendar information:
1. From the open Calendar, press Options and select Settings.
2. Scroll to Lunar calendar.
3. Select Off. 

Calendar alarm tone Scroll to select desired tone (after a brief pause tone will play).
Default view Select Month view, Week view, or Day view.
Week starts on Choose starting day of the week.
Week view title Choose Week number of the year (e.g. Week 12) or Week 

dates (e.g. 20.03.05-26.03.05). 

Note: Week view title setting is available only if Week starts on is set to Monday. 
Week numbers are shown in layouts only if Week starts on is set to Monday.

Note: Chinese Lunar Calendar will appear only when a Chinese language 
is selected as the phone display language.
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MESSAGES
Messages menu contains these main options:

VOICE MAIL
Voice mail service stores voice messages from callers who could not reach you. The 
messages are stored on your wireless service provider’s network, not on your phone. 
You must first subscribe to voice mail from your wireless service provider before using 
this service.

Listen to Voice Mail Messages
When you receive a new voice mail message, an alert sounds if ringtone is not set to 
silent, and the voice mail icon  displays.
1. Press and hold  in standby mode to dial your voice mail message centre.

• You can also press  and  in standby mode.
2. Follow the prompts to listen to your voice mail messages.

If the phone asks for the voice mailbox number, enter the voice mail message centre 
phone number given to you by your wireless service provider.

To change the voice mailbox number, from Messages application:
1. Open Voice mail.
2. Press Options and select Change number.

MESSAGES
Send, receive, and store messages from text message (SMS), multimedia (MMS), 
e-mail, service and cell broadcast. 

Messaging Types
SMS: Short Message Service allows you to send and receive short text messages to 
mobile phones with short text message capability on the same network or any network 
that has a roaming agreement. A small black and white picture message can be inserted 
in the message.
MMS: Multimedia Messaging Service allows you to send messages containing images, 
video clips, sound clips and text. Presentation templates are available to place media 
objects into prearranged layouts. Multimedia messages can be sent to another mobile 
phone with multimedia capability or to an e-mail address.
E-mail: Create, send and receive e-mail messages, which can have attachments.

Voice mail Messages
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Smart messages: Messages containing data such as electronic business cards, ringing 
tones, Java™ applications or configuration data such as WAP and multimedia settings.

These services do not work by sending messages directly to the recipient, instead they 
store and forward messages through specifically designated network servers.

Before Using Messaging Services
Before you can use multimedia or e-mail messaging, your connection settings must be 
configured.
Your multimedia configuration settings may already be set by your wireless service 
provider. If settings are not available, contact your wireless service provider.
Your e-mail configuration settings are provided by an Internet Service Provider (ISP) 
that supports POP3/IMAP4/SMTP protocols.
Before you can send and receive e-mail:
(1) you need a subscription for data services, (2) contract must be set up with an ISP, (3) 
you must configure an Internet Access Point (see Access Point Settings on page 96). 

Messages Menu Main Options 

In some main Messages options, icons indicate the message type:

To view Cell Broadcast messages, see page 56.

New message
Create new messages.

Drafts
Stores unfinished messages.

Inbox
Stores received messages except e-mail and 
cell broadcast.

Sent
Stores sent messages.

My folders
Stores moved messages and templates.

Outbox
Temporarily stores messages waiting to be 
sent.

Mailbox
Receives and stores e-mail messages.

Reports
Delivery status on text, multimedia, and smart 
messages.

Text message Bluetooth Cell broadcast

Multimedia Infrared Unknown

E-mail WAP push Attachment

Smart
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CREATE NEW TEXT MESSAGES
From Messages application:
1. Open Messages.
2. Open New message and select Text message.
3. In the To field, type in recipient’s phone number.

• To retrieve from Contacts card, press , or Options and 
select Add recipient. Scroll to desired name and press OK. 
Select desired number if entry has several numbers. 

• To separate multiple recipients, enter a semicolon (;) by 
pressing .

4. Scroll  to move to text entry field, enter text. 
5. If desired, press Options and select Insert > 

6. To send, press  or press Options and select Send.

CREATE NEW MULTIMEDIA MESSAGES
From Messages application:
1. Open Messages.
2. Open New message and select Multimedia message.
3. In the To field, type in recipient’s phone number or e-mail 

address.
• To retrieve from Contacts card, press , or Options and 

select Add recipient. Scroll to desired name and press OK. 
Select desired number if entry has several numbers. Card 
must have a phone number or e-mail address to be visible.

• To separate multiple recipients, enter a semicolon (;) by pressing . 
4. Scroll  to move to text entry field, enter text. 
5. If desired, press Options and select Insert > 

Picture Picture msg. from Media Gallery
Template Select from a list of sentences in which you fill in the blank

Note: Text messages have a 160 character limit. The counter keeps track 
of total characters available. If you use more than 160 characters, a 
new text message starts, but appears as one message or more at 
destination. You may be charged for more than one text message.

Image Image from your Images folder
Sound clip Sound clip from your Sound clips folder
Video clip Video clip from your Video clips folder
New image New image from Camera
New sound clip New sound clip from Voice Recorder
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6. To send, press  or press Options and select Send.

Create Presentation
Choose from four presentation templates to create an impressive multimedia show.
1. Complete steps 1, 2 and 3 in Create New Multimedia Messages on page 42.
2. Press Options and select Create presentation.
3. Select from the list of templates:

• Image template
• Video template
• Sm. image tem.
• Temp. with title

4. Highlight desired template, press Select.
5. Scroll to the video, text, or image region of the template to highlight it.
6. If desired, press Options and select Insert >    

7. Press Options and select: 

Slide Add new slide to message

Note: If multimedia messages are sent to devices without 
multimedia or e-mail capabilities, the recipient may receive 
a message containing a link to a web page.

Image Image from your Images folder
Sound clip Sound to play at start of show
Video clip Video clip from your Video clips folder
Note Note from Notepad (if a text region is highlighted)
New image New image from Camera
New slide Add new slide to show

Note: Available choices depend on region highlighted.

Send Send completed presentation
Full screen Edit in full screen view
Normal screen Edit in normal screen view with signal icon, slide number, and 

softkey labels in view
Edit text Start or stop text editing, change text colour
Preview message Preview entire message before sending
Remove > Remove image, sound clip, video clip, or current slide
Backgrnd. settings > Set background colour, add background image to current slide 

or entire presentation, remove background image
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8. To send, press  or press Options and select Send.

CREATE NEW E-MAIL MESSAGES
Before you can write an e-mail message, at least one mailbox must be configured. See 
page 48.
From Messages application:
1. Open Messages.
2. Open New message and select E-mail.
3. In the To field, type in recipient’s e-mail address.

• To retrieve from Contacts card, press , or Options and 
select Add recipient. Scroll to desired name and press OK. 
Card must have an e-mail address to be visible.

• To separate multiple recipients, enter a semicolon (;) by 
pressing .

4. Scroll  to enter recipients in Cc (courtesy copy) field and type subject in subject 
field (both fields optional).

5. Scroll  to move to text entry field, enter text. 
6. If desired, press Options and select Insert > 

7. To send, press , or press Options and select Send.
• To view, add, or remove attachments before sending, press Options and select 

Attachments.
• If phone is set to send e-mail during next connection to mailbox, then pending e-mail 

will be stored in Outbox. Change setting by pressing Options and selecting Sending 
options.

COMMON WRITING TASKS
• To cut, copy and paste text, see page 24.
• To save before sending, press Close. Message is automatically stored in Drafts 

folder.
• To match names in To and Cc fields to names in Contacts, press Options and select 

Check contacts.

Effect settings > Set transition effect between images and between slides

Image Image from your Images folder
Sound clip Sound clip from Sound clips folder
Video clip Video clip from Video clips folder
Note Note from Notepad
Template Select from a list of sentences in which you fill in the blank
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RECEIVE NEW MESSAGES
When you receive a new message, the standby screen displays a new message icon 

 and a note indicating the number of new messages. Press Show to read the 
message. If there is more than one message, press Show to open the Inbox, then scroll 
to the desired message header and open.

INBOX (RECEIVED MESSAGES)
Inbox stores received text, multimedia, and smart messages. Incoming Bluetooth; 
Infrared; WAP push; SIM; and voicemail, e-mail waiting messages are also placed here.

The messages remain in the Inbox until you move them to My folders or delete them.
Unread messages have incoming arrow appearing with icon that identifies type of mes-
sage.
Read messages have no arrow with icon.

Read or Play Inbox Messages
From Messages application:
1. Open Messages.
2. Scroll to Inbox and open.
3. A list of message headers displays, indicating type of message sender (Multimedia, 

Bluetooth, etc.) and icon. Scroll to desired message header and open.
• The message may first need to be retrieved from the network server depending on 

the message type or if it contains large files.
• Press Play if needed for video clips, sound clips and presentations.
• If the message contains an image, it opens automatically.

Reply to and Forward Inbox Messages
From Messages application:
1. Open Messages.
2. Select Inbox.
3. Scroll to desired message, press Options and select Reply > To sender or To all or 

Forward.
4. To reply, enter text in text field.

To forward, enter recipient(s) phone numbers or e-mail addresses.
5. Press .

Note: Scroll  to decrease or increase audio volume.

Note: The phone may not allow you to copy, modify, transfer, or forward 
some copyrighted images, ringtones and other content.
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Store Inbox Messages
From Messages application:
1. Open Messages.
2. Select Inbox.
3. Highlight desired message.
4. Press Options and select Move to folder.
5. Choose a folder and press OK.

Save Attachment or Data
You can save images and media clips from messages. Attachments to e-mail, links to 
streaming media, Contacts cards, Calendar items, ringtones, and configuration data can 
also be saved.
1. Open desired message.
2. Press Options and select Save.

• If needed, the data is directed to the appropriate application.
3. If needed, select to save either in phone memory or miniSD Card, press OK.
4. If needed, scroll to desired folder to place object or attachment, press Open or 

Save. If desired, rename the file. Press Save.

Find Phone number, E-mail or Web Address in Message
Within received messages, you can find a phone number, e-mail or web address within 
message text and use it to call, write, access a service or create a Contacts card.
From Messages application:
1. Open Messages.
2. Scroll to Inbox or My folders and open.
3. Scroll to desired message and open. 
4. Press Options and select Find > Phone number, E-mail address, or Web 

address.
5. Text and numbers are highlighted when found. If more than one is found, scroll to 

highlight desired item.
6. Press  to Send a message, Add to Contacts to add or update Contacts, Call a 

number, Go to web address, or Add to bookmarks to add web address to 
bookmarks. 

Note: Received applications or games can be installed directly from the Inbox. 
When you open the message, the phone asks if you want to install it now.
An attachment or object remains in the Inbox after it is saved to another 
application. To save memory space, delete message from Inbox.
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MY FOLDERS (ORGANISE MESSAGES) 
Store your messages in My folders. You can also create and name new folders. For 
example, create a folder for Friends and one for Family messages. Folders can also be 
created by message type or by subject.
From Messages application:
1. Open Messages.
2. Select My folders.
3. Press Options and select New folder.
4. Enter a name for your folder and press OK. 

To rename or delete a folder, from Messages application:
1. Open Messages.
2. Select My folders.
3. Scroll to desired folder, press Options and select Rename folder or Delete.

Templates
Templates are short sentences in which you fill in the blank, then send the message. 
Template sentences can also be inserted into longer messages.
From Messages application:
1. Open Messages.
2. Select My folders. Select Templates.
3. Scroll to desired text. Press Options and select Send > Via text message, Via 

multimedia, or Via e-mail.
4. Press  and a new message opens with template text already placed. 
5. Fill in needed information and press .

To create your own template text, from Messages application:
1. Open Messages.
2. Select My folders. Select Templates.
3. Press Options and select New template.
4. Enter text, numbers, or symbols, and press Done.

Note: You cannot create folders within a folder.

Note: In longer messages, at cursor, press Options and select 
Insert > Template. Template text is placed at cursor.
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MAILBOX (E-MAIL MESSAGES)
E-mail is received and stored in a separate mailbox. Once you set up a mailbox, Mailbox 
will be renamed and appear with its new name in the main Messages list. You can set 
up to 6 mailboxes, each appears separately in the main Messages list.

After your e-mail is set up, use the mailbox to view and send e-mail. Files such as 
images, sound and video clips can be attached from phone memory or miniSD Card. 
Supported e-mail clients include a standard POP3, IMAP4, SMTP, MIME client. E-mail 
messaging takes place over CSD and GPRS bearerset using standard Internet e-mail 
protocols over TCP/IP.

Configure Mailboxes
From Messages application:
1. Open Messages.
2. Press Options and select Settings.
3. Scroll to E-mail and open.
4. Highlight Mailboxes and open.
5. Press Options and select New mailbox.
6. Enter information in fields. Fields marked in the phone with a red asterisk (*) must 

have an entry. 

Note: Before you can send or retrieve e-mail, you must first set up a mailbox.

Mailbox name Use default name or enter a name for your mailbox and press 
OK.

* Access point in use Default Access Point supplied by wireless service provider
* My e-mail address Enter your own e-mail address and press OK. May be supplied 

by wireless or Internet service provider.
* Outgoing mail 
server

Enter SMTP mail server address.

Send message Choose During next conn. or Immediately.
Send copy to self Select Yes or No.
Include signature Select Yes to enter a signature for outgoing messages.
User name Enter a name to log into service provider remote mailbox.
Password Enter password. 
* Incoming mail 
server

Enter address of incoming mail server (POP or IMAP), supplied 
by service provider.

Mailbox type Select POP3 or IMAP4.
Security Select Off or TLS (Transport Layer Security). TLS ensures pri-

vacy. Determined by Internet service provider.
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